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Hand-Held Wireless Transmitter

Description

Functional Description

The ST-4T and ST-8T are hand-held radio-frequency (RF) transmitters. The units
are designed to operate with the SmarTouch STS viathe ST-CP, control processor.
The hand-held transmitter is available with four (ST-4T) or eight (ST-8T) button
controls. Depression of any fixed button on the button panel initiates a RF signal
transmission to the ST-CP.

Both hand-held transmitters have a power-saving mode, known as sleep mode, to
extend battery life. Units are continually in sleep mode until a button is depressed.
The unit activates immediately. It is not necessary to hold down a button.

Physical Description

ST-4T and ST-8T electronic hardware is housed in a slim, high-impact molded
ABS black plastic enclosure, as shown on the next page. A button array on the
printed circuit board is covered by a button panel. All button panels include custom
engraving with large light gray button caps and black finish. Refer to the latest
version of the CRESNET |l Engraving Worksheet for the ST-4T and ST-8T (Doc.
5704 and 5705, respectively) for engraving directions.

A red Transmit LED is located above the button panel cover. The Transmit LED
indicates RF transmission and illuminates when a button is depressed. It also has
the auxilliary function of illuminating when a new transmitter RF ID codeis
programmed into the unit.
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A standard nine-volt battery isincluded with all units. Accessto the battery is

permitted after the battery cover, located on the underside of the unit, is removed. A

sensor (photo transistor) used to program an identity code is also located in the
battery compartment, as shown below.

Battery Compartment (Rear View)
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This illustration
reveals the rear
view of the ST—4T
The ST—8T is
identical to this
drawing, except
for model number
nomenclature on
the FCC ID sticker.

BATTERY COVER
REMOVED TO

SENSOR

OCATION.

Leading Specifications

The table below provides a summary of leading specifications for the hand-held
transmitters. Dimensions and weight are approximations rounded to the nearest

thousandth unit.

Leading Specifications of the ST-4T and ST-8T

SPECIFICATION

DETAILS

Battery

CRESNET Il Workshop
CRESNET Il Operating System
SmarTouch Operating System
STS VisionTools for Windows
Compiler

Dimensions & Weight

9v DC

Version 5.0 or later
SR30222.0PS or later

Any

Version 10.4 or later
3.09.17 or later

Height: 6.500 in (16.510 cm)
Width: 2.750 in (6.985 cm)
Depth: 0.800 in (2.032 cm)
Weight: 0.300 Ib (0.200 kg)
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NOTE: This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interferencein a
residential installation. The equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which
can determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

B Reorient or relocate the receiving antenna.
B Increase the separation between the equipment and receiver.

B Connect the equipment into an outlet on a circuit different from that to which
the receiver is connected.

B Consult the dealer or an experienced radio/TV technician for help.

As of the date of manufacture, the unit has been tested and found to comply with

specifications for CE marking. c €

Setup

Identity Code

Every hand-held wireless transmitter communicating with either the ST-CP
reguires a unique RF identity code (ID CODE). There are 254 possible two-digit
hexadecimal alphanumeric codes ranging from 01 to FE. To maintain code diversity
within SmarTouch STS, use codes between 10 and FE for the transmitters.

NOTES: The RFID CODE on the hand-held transmittersis factory set to 11.
Do not use 00 or FF asan RF ID.

Do not confuse RF 1D with network (NET) ID.

Use STS VisionTools for Windows to set an RF ID CODE. Select ViewPort from
the Tools menu; the “ Crestron Performance Viewport” dialog box appears.
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Crestron Performance Viewport Dialog Box

i Creztron Performance Yiewport

Fil=  Edit Setup

Port Settings:
COM1 38400 N

File Tranzfer

Check Ops/Comm
Report Modules

Report Metwork Devices
Find Rack

Soft Reszet

Hard Reset

Eraze Permanent kemaorn
Boot From RO

Send Break

F&

F4
Alt+B
Fa
F10

Al

i [=] B3

Send Dperating System. .
Send Program...

Load Metwork Device...
Set Metwork, 1D,

Set Trangmitter [D...

Identify Transmitter 10...
Set Baud Rate...
Update BOM...

Ale+F
Fa

From the Options menu in the dialog box, select Set Transmitter ID to open the “ Set
Transmitter ID” dialog box. Enter atwo-digit hexadecimal number ranging from 03

to FE. Click OK to confirm.

Set Transmitter 1D Dialog Box

Set Tranzmitter 1D

]|

r—

Enter the desired tranzsmitter ID as
a Z2-digit Hexadecimal number.

1] .4 I Cancel

Programming

STSVisionTools for Windows contains sample projects, STAT.prj and ST8T .prj,
that can be used when programming the hand-held wirel ess transmitters. Simply
copy the respective sample project by selecting Copy Project from the File menu of

an open project. The “Copy Project” dialog box is displayed.
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Copy Project Dialog Box

Copy Project

From: |c:"wtw\pmiecls\st-ll.pli Browse. .

To: |-:::\\rtw\pmiecls\remute—1|.pri Browse. .

Current Status

Copy graphics files

" To default graphics directory

* To project directory

Help... | Copy Close

NOTE: Theillustration above shows what the “ Copy Project” dialog box would
look like if the programmer were to copy the ST-4T sample project with the new
project name, remote-1.

Asillustrated, a"From™" and "To" field is provided. If the desired project is not
present in the field, directly key in the path name (at the From: box) or select
Browse to display the "Open" dialog box and scroll through directories to establish
the correct path of a desired source for the copy. The destination path is entered in
the same manner. Once source and destination paths have been chosen, select Copy
to initiate project copying. By default, all copied graphic files are copied to the same
directory as the project or touchpanel.

The sample projects for the hand-held transmitters have one page each. The ST-4T
page and ST-8T page have four and eight momentary-type buttons, respectively.
Each large button has two join numbers associated with it, one for each half of the
button. Commands such as VOLUME UP and VOLUME DOWN are usually
assigned to the separate button halves; operation of each half is achieved by
pressing down on that side of the button. Refer to the following illustration of the
sample ST-4T page. Notice the join number assignments for each button.
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Open Page of STAT.PRJ
chwiwiprojectshst-4t pri; 5T-4T
o
ST-4T
FOUR BUTTOMN TRAMSMITTER
23 Click on a light grey button and
EITHER:
Azszign separate functions to each
| - half of the long buttons for up to
101 3 separate functions -
OR
Assign the same functions to
18219 both halves of a long button
for a mimimum of 4 functions.
CAE0Y
Note: Do not change the join
CRESTROMN numbers of the buttons as they
represent the physical location
of the buttons on the transmitter,
and the program will not work.
i )|

DO NOT reassign join numbers in the new project, since they represent the
physical location of actual buttons on the transmitter. Use STS/VTW to assign
device commands when customizing the SmarTouch system. To access the
functional properties of the button, simply right-click on the object and select
Function from the pop-up menu. The "Function" dialog box appears.

Function Dialog Box Shown for Button with Join Number 2

Function [_ [ ] |

Join 2

Logic: | Momentary

-l

Macro: | None

-l

Press: | Mone

-l

— Command

Device: Il

Function: I

Select | Delete

— Button Achion
* Press " Release

— Mouze Button
i Left " Right
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One possible programming technique is to assign the same command to both join
numbers on the large button so that the entire button has a single command.
Otherwise, assign a unique command to each join number so that the button has
dual functionality. For example, commands such as VOLUME UP and VOLUME
DOWN are usualy assigned to the separate button halves; operation of each half is
achieved by pressing down on that side of the button. Use caution when assigning
two commands to a single large button. Due to the sensitivity of the unit, depressing
the large button in the center may result in an undesired activity or no activity at all.

If you draw your own project, remember to change the target typeto ST-4T or ST-
8T in the dialog box after selecting New and Project from the File menu.
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Problem Solving

Troubleshooting

The table below provides corrective action for possible trouble situations. If further
assistance is required, please contact a CRESTRON technical support

representative.

ST-4T/-8T Troubleshooting

does not
illuminate.

POSSIBLE
TROUBLE CAUSE(S) CORRECTIVE ACTION
LED onunit  No battery in unit or Install new battery.

battery is dead.

Unit is in sleep mode.

Depress and hold any button until unit
transmits.

Intermittent
response
during
transmission.

Refer to causes when

LED does not

Refer to corrective action when LED does
not illuminate.

Receiver is blocked or

moved.

Verify that heavy metal is not in vicinity of
transmission.

ST-CP is in vicinity of

metal.

Verify that large amount of metal is not
blocking transmission.

No response
from
SmarTouch
system.

Refer to causes when

LED does not
illuminate and

intermittent response
during transmission

Refer to corrective action when LED does
not illuminate and intermittent response
during transmission occurs.

NET ID of receiver is

incorrectly set.

Enter Performance Viewport from the
STS/VTW software. Depress the F4 key to
poll the network. Verify that the NET ID for
the receiver is properly set to match the
SIMPL program.

NOTE: After changing the ST-CP identity
code, disconnect and reconnect the network
connector.

RFIDor IR ID is

incorrectly set.

Verify that the RF ID is properly set to match
the SIMPL program.

NOTE: NET ID and RF ID are separate
parameters.

Program does not
match hardware.

Verify correct program is loaded in system
via Performance Viewport.

Receiver is unplugged

(no power).

Verify power to the receiver.

Two or more receivers
are too close together.

Verify that multiple receivers are properly
spaced (>50 feet) from each other.

Wrong transmitter in

use.

If multiple transmitters are accessible, verify
proper unit is used.
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Further Inquiries

If after reviewing this Operations Guide for the hand-held transmitter, you can not
locate specific information, please take advantage of CRESTRON's award winning
technical support team in your area. Dial one of the following numbers.

Inthe US, call (888) CRESTRON [(888) 273-7876] - the call istall
free or (201) 767-3400.

In Europe, call +32.15.730.974.
In Asig, call +852.2341.2016.
In Latin America, call +525.574.15.90.
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Crestron Electronics, Inc.

15 Volvo Drive Rockleigh, NJ 07626

Tel: 888.CRESTRON / 201.767.3400
Fax: 201.767.7576 / BBS: 201.767.5506
http://www.crestron.com

Specifications subject to
change without notice.
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